CITY CLERK'S DEPARTMENT
Access to Information & Privacy Division

File No.: 04-1000-20-2022-234

June 8, 2022

s.22(1)

Dear S-22(1)

Re: Request for Access to Records under the Freedom of Information and Protection
of Privacy Act (the “Act”)

| am responding to your request of May 1, 2022 under the Freedom of Information and
Protection of Privacy Act, (the Act), for:

Records related to DP-2021-00495 for 1265 East 19th Avenue including
correspondence, memos, decisions, and forms. Date range: June 1, 2021 to April
30, 2022.

All responsive records are attached. Some information in the records has been severed,
(blacked out), under s.3(5)(a), s.15(1)(l), and s.22(1) of the Act. You can read or download
these sections here:

http://www.bclaws.ca/EPLibraries/bclaws new/document/ID/freeside/96165 00.

Please note: Architectural plans and drawings are available from the Development and Building
Services Centre with the owners’ written permission. Please see the following link for more
information on obtaining property records which also explains in greater detail the process for
obtaining or viewing plans, and to submit your request online:
http://vancouver.ca/home-property-development/get-copies-of-your-building-plans.aspx

Issued permits are routinely available on a fee for service basis from the Property Research
section of the By-law and Compliance Administration branch, Development, Building &
Licensing Department. To access these records please contact Property Research at
property.research@vancouver.ca

Permits can also be searched online at the following link: www.vancouver.ca/permit-search

Please see the following link which also provides more information on obtaining property
records: https://vancouver.ca/home-property-development/request-property-research-and-
copies-of-permits.aspx

Under section 52 of the Act, and within 30 business days of receipt of this letter, you may ask
the Information & Privacy Commissioner to review any matter related to the City’s response to
your FOI request by writing to: Office of the Information & Privacy Commissioner,

City Hall 453 West 12th Avenue Vancouver BC V5Y 1V4 vancouver.ca
City Clerk's Department tel: 604.829.2002 fax: 604.873.7419



info@oipc.bc.ca or by phoning 250-387-5629.

If you request a review, please provide the Commissioner’s office with: 1) the request number
(#04-1000-20-2022-234); 2) a copy of this letter; 3) a copy of your original request; and 4)
detailed reasons why you are seeking the review.

Yours truly,

[Signed by Cobi Falconer]

Cobi Falconer, MAS, MLIS, CIPP/C
Director, Access to Information & Privacy

cobi.falconer@vancouver.ca
453 W. 12th Avenue Vancouver BC V5Y 1V4

If you have any questions, please email us at foi@vancouver.ca and we will respond to you as
soon as possible. Or you can call the FOI Case Manager at 604-871-6584.

Encl. (Response package)

pm
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s.3(5)(a) - Routinely available (see response letter)
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Shape Your City Vancouver : Summary Report for18 February 2020 to 26 September 2021

ENGAGEMENT TOOLS SUMMARY

0 1

0

0 0

FORUM TOPICS SURVEYS NEWS FEEDS QUICK POLLS GUEST BOOKS
L J
STORIES Q8A S PLACES
Tool Type Contributors
Engagement Tool Name Tool Status Visitors

Registered Unverified Anonymous

Survey Tool 1265 E 19th Ave development application 5 0 0 0
comments
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Shape Your City Vancouver : Summary Report for18 February 2020 to 26 September 2021

INFORMATION WIDGET SUMMARY

3

DOCUMENTS

0 0 0

PHOTOS VIDEOS FAQS

0

KEY DATES

Widget Type
Engagement Tool Name Yalioe Views/Downloads
Document Site plan 9 9
Document Elevations / !
Document Garage details 6 6
Key Dates Key Date ! !
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From: "Toronchuk, Jonathan" <Jonathan.Toronchuk@yvancouver.ca>
To: "Charles fawkes"
Date: 8/27/2021 1:41:09 PM
Subject: Development Permit - 1265 E. 19th Ave. - DP-2021-00495 - Decision
+ Prior-to Letter
Attachments: 1265 E. 19th Ave. - DP-2021-00495 - Prior To Letter -
2021.08.27.pdf
1265 E. 19th Ave. - DP-2021-00495 - Prior To Letter -
2021.08.27.docx

Hello Charles,

The Development Permit application for 1265 E. 19th Ave. - DP-2021-00495 has been approved,
subject to conditions. Please find attached Prior-to Letter with conditions that need to be satisfied,
prior-to issuance of any development permit.

Once you are ready to submit drawings and documents in Response to the Prior-to Letter; please note
the following requirements and instructions to provide for PTR submission:

Electronic files (PDF/word) of the following list via email (or USB, or fileshare FTP site)
including:
8 PDF of all drawings and any revised documents
8 A word document with your written explanation and comments describing how you
have addressed each of the conditions and specific rationale for any changes.
Please note that this will be extremely helpful with our processing, especially
considering getting the information through to various review groups. Clear and
comprehensive applications are the best means of speeding up your application
timeline.
For your convenience | have attached both a PDF and word document copy of
the PTL for your review and response; please feel free to respond with a word
document in the following format:
Example PTR format:

Development Review Branch conditions:

1.2 provision of the following notations to be included on the submitted
plans:
i All building dimensions, setback and yards are to the outside of
cladding”;
Applicant Response: notations included and revisions made to the
following pages: A-1.0, A-1.1, A-2.1

Should you require anything further please let me know.
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Thx
Charles Fawkes

On Fri, Jun 25, 2021 at 10:46 AM Toronchuk, Jonathan
<Jonathan.Toronchuk @vancouver.ca> Wrote;

Hello Charles,

Thank you for your patience and understanding while we work to adapt to current
circumstances. The project was discussed in areview team meeting last week and some
internal processes/coordination was required prior to moving forward with public
notification. The proposed Development project for 1265 E. 19th Ave. is now ready for
public notification.

A sitesignisrequired to beinstalled at the project site facing E. 19th Ave. See
attachments for the Site Sign; please read each of the attachments carefully for how to
design the site sign.

Before you print the sign or have it manufactured, please send me a pdf for approval.
Once | review and approve the site sign, | will inform you to manufacture and install the
sign on site. When the sign isinstalled on site you must send me photographs of the sign
installed.

Should you require anything further please let me know.

Please Note:

The City of Vancouver's Development, Buildings, and Licensing Department is adapting
to the quickly evolving COVID-19 situation. City staff are working to maintain services
and public safety remains our top priority. Please expect some longer than normal
response times.

Thank you for your patience and understanding while we continue to provide service as
best we can during this time.

Regards,

JONATHAN TORONCHUK | Project Coordinator
Development, Buildings, & Licensing

City of Vancouver | 515 W 10th Ave

Vancouver | BC V5Z 4A8

E ogonathan.toronchuk@vancouver.ca
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August 27, 2021

Charles Fawkes
1701 Waterloo Street
Vancouver, BC V6R 3G3

RE 1265 E 19TH AVENUE, Vancouver, BC V5V 1L2
Development Application Number DP-2021-00495

On behalf of the Director of Planning, your application has been approved to develop on this site
for a to demolish existing One-Family Dwelling character home to develop a two storey One-
Family Dwelling with a Secondary Suite, and a two-car garage at the rear of the site having
vehicular access from the lane..

A permit may be issued upon the completion of the revisions and conditions noted below under
items 1.0 to 2.3 of this “prior-to permit issuance” letter.

IMPORTANT!Il'  HOW TO SUBMIT YOUR REVISIONS

Contact your project coordinator in advance of your drawings and documents being ready for
submission to coordinate your submission. You may contact Jonathan Toronchuk at (604) 829-
9627 8:30 a.m. to 5:00 p.m., Monday to Friday. Please do not mail, drop-off or courier your
response because this will delay the processing of your application.

Partial submissions will not be accepted. Written response describing how you have addressed
each of the Prior to Letter conditions is required (detailed explanation of changes assists us to
understand your rationale and convey the information efficiently and effectively to all review
groups).

1.0 Prior to the issuance of the Development Permit, revised digital drawings shall be
submitted, to the satisfaction of the Director of Planning, clearly indicating:
Development Review Branch conditions:

1.1 Design development to ensure “light well” located at Basement Level does not
project more than 1m (3’-3”) depth from face of building:

(Note to Applicant: The current proposed “light well’ at the Basement level
projects 6’-6” from face of the building and must be revised to comply.)
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1.2 Design development to ensure only one laundry room is provided for each
dwelling:

(Note to Applicant: The current proposed plans indicate (2) laundry rooms at the
basement level of the primary dwelling)

1.3 provision of the following notations to be included on the submitted plans:

i. “The design of the parking structure regarding safety and security shall be in
accordance with Section 4.13 of the Parking By-law”;

ii. “All building dimensions, setback and yards are to the outside of cladding”; and

(Note to Applicant: Ensure floor plans indicate dimensions are to cladding.)

ii. “Mechanical equipment (ventilators, generators, compactors, and exhaust
systems) will be designed and located to minimize noise impacts on the
neighbourhood and comply with Noise By-law No. 6555”

Landscape Review conditions:
1.4 Design development to ensure safe retention of all existing trees as follows:

i. Revise the tree protection barriers of Tree #1 to match with arborist report
requirement, and relocate the gas line to be outside the tree protection zone.

(Note to Applicant: The tree barrier size has to be no less than 18’-9” at North
and East side, and 4 ft at West side. Ensure dimensions to be measured from the
edge of tree trunks)

ii. Add tree protection barriers and dimensions for Tree #7, #8 and #9, and arborist
specifications for tree retentions.

(Note to Applicant: Refer to Landscape Condition 1.8)

iii. Relocate the garbage bin pad to be outside CRZ of Tree #9

iv. Provide section details of the proposed structures within CRZ of retained trees
with “alt” footings, including the new fence at south and side property lines, new
stairs and retaining wall within CRZ of Tree #6 and 7, the East side foundation
wall of the garage within CRZ of Tree#9.

(Note to Applicant: Further comments will be provided after reviewing structural
details)

1.5 Design development to verify the location of Tree #7 by updating survey plan.
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2.0

1.6

1.7

1.8

(Note to Applicant: The location of the tree at survey plan didn’t match with
arborist report finding)

Provision of coordinated and complete site plan.

(Note to Applicant: The layout of outdoor patio and stairs on SITE PLAN didn’t
match with floor plans; also add tree #5 on SITE PLAN)

Provision of updated Arborist Report to assess the development proposal and
construction impact on trees, and provide tree retention measures, updating tree
management plan in the context of site plan.

(Note to Applicant: Include but not limited to assess the construction activities
within the critical root zone of Tree #1, #6, #7 and #9, and specify “alt” footings;
confirm tree #3, #4, #8 to be retained or removed.)

Provision of an Arborist Letter of Assurance signed and dated by owner, arborist
and contractor.

(Note to Applicant: The letter of assurance should include all construction
activities that require arborist supervisions.)

Condition(s) to be met prior to the issuance of the Development Permit:

Development Review Branch conditions:

21

2.2

Written confirmation that Building Review Branch comments under 4.8 have
been acknowledged and understood, is required to be submitted as part of the
“prior-to” response.

Written confirmation that Building Review Branch comments under 4.4 have
been acknowledged and understood, is required to be submitted as part of the
“prior-to” response.

Engineering Services conditions:

23

Provision of a copy of a current title search for each parcel of land involved in the
development site which must include copies of all non-financial charges and legal
notations listed on each title search.

(Note to Applicant: Title search must include current title owner(s))
Examples of common non-financial charges include: Statutory Right of Way,

Right of Way, Covenant, Easement, Option to Purchase, and Easement and
Indemnity.
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3.0

4.0

Examples of financial charges, which are not required, include: Mortgage,
Assignment of Rents, and Builders Liens.

This information may be obtained from the Land Title Office in New Westminster.
An applicant may require advice or assistance from a Solicitor, Notary, Realtor,
BC Land Surveyor, or Land Agent to obtain this information.

We reserve the right to ask for an updated title search and charges prior to
issuance of the permit

Conditions of the Development Permit:

3.1

3.2

3.3

3.4

All approved off-street vehicle parking, loading, and unloading spaces, and
bicycle parking spaces shall be provided in accordance with the relevant
requirements of the Parking By-law prior to the issuance of any required
occupancy permit, or any use or occupancy of the proposed development not
requiring an occupancy permit, and thereafter permanently maintained in good
condition.

All landscaping and treatment of the open portions of the site shall be completed
in accordance with the approved drawings prior to the issuance of any
required occupancy permit, or any use or occupancy of the proposed
development not requiring an occupancy permit, and thereafter permanently
maintained in good condition.

(Note to Applicant: In cases where it is not practical, due to adverse weather
conditions or other mitigating factors, to complete the landscaping prior to
occupancy of a building, the City will accept an Irrevocable Letter of Credit
[amount to be determined by the City] as a guarantee for completion of the work
by an agreed upon date.)

In accordance with Protection of Trees By-law Number 9958, the removal and
replacement of trees is permitted only as indicated on the approved Development
Permit drawings.

This Development Permit is valid for a period of 12 months from the date of
issuance - unless otherwise validated by a Building Permit.

Notes to Applicant:

4.1

4.2

It should be noted that your Development Permit will be issued when you have
complied with all the above conditions. However, if these conditions have not
been complied with on, or before February 28, 2022, this Development
Application may stand refused.

A new Development Application will be required for any significant changes. This
approval is subject to any change in the Zoning and Development By-law or
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4.3

4.5

4.6

4.7

4.8

other regulations affecting the development that occurs before the permit is
issuable. No permit that contravenes the by-law or regulations can be issued.

If this application necessitates the demolition of existing residential rental, per
Section 10.8.2 and except as set out in section 10.8.3, where development
necessitates the demolition of existing residential rental accommodation, no
development permit shall be issued for the demolition unless and until a
development permit for the new development has been issued. No development
permit shall be issued for the demolition unless and until a development permit
for the new development has been issued.

(Note to Applicant: The development permit for the new development shall not be
issued unless and until all building permits for the new development and a
building permit for the demolition are issuable.)

If this Development Application included a written notification of neighbouring
property owners or other interested parties, a copy of this letter will be sent to all
respondents advising them of the decision.

The Canadian Electrical Code regulates high voltage overhead conductor
clearances from structures and dielectric liquid-filled transformer clearances from
combustible building surfaces, doors, windows, and ventilation openings. All
structures must have a horizontal distance of at least 3 m from existing BC Hydro
high voltage overhead conductors. Combustible building surfaces, windows,
doors, and ventilation openings must be located at least 6 m from dielectric
liquid-filled, pole-mounted BC Hydro transformers, unless an acceptable non-
combustible barrier is constructed between these transformers and combustible
building surfaces, doors, windows, or ventilation openings.

If the building design cannot meet these requirements, modifications must be
made. If you wish to discuss design options, please contact Electrical
Inspections Plan Reviewer at 604.871.6401.

This application may be eligible for Development Cost Levy (DCL) Waiver.

Additional fees, conditions and processing time may be required should a
Development Cost Levy DCL Waiver be pursued. More information is
available at: https://vancouver.calfiles/cov/development-cost-levies-

bulletin.pdf

Submission of most Building Permit applications now requires an appointment.
When your Building Permit application is ready, please phone 604.873.7611 to
book an appointment for an application intake with the Project Coordinator who
will manage your application. Only full and complete applications will be
accepted. For additional information on obtaining a Building Permit for this
proposal please visit vancouver.ca/building-permit. If you need advice in
preparing your application, you may book an enquiry appointment
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(604.873.7611), or submit questions to https://vancouver.ca’lhome-property-
development/contact-development-buildings-or-licensing.aspx

Yours truly,

Jonathan Toronchuk,
jonathan.toronchuk@vancouver.ca
(604) 829-9627
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August 25, 2021

Charles Fawkes
1701 Waterloo Street
Vancouver, BC V6R 3G3

RE 1265 E 19TH AVENUE, Vancouver, BC V5V 1L2
Development Application Number DP-2021-00495

On behalf of the Director of Planning, your application has been approved to develop on this site for a to demolish existing
One-Family Dwelling character home to develop a two storey One-Family Dwelling with a Secondary Suite, and a two-car
garage at the rear of the site having vehicular access from the lane..

A permit may be issued upon the completion of the revisions and conditions noted below under items 1.0 to 2.3 of this “prior-
to permit issuance” letter.

IMPORTANT!!!  HOW TO SUBMIT YOUR REVISIONS

Contact your project coordinator in advance of your drawings and documents being ready for
submission to coordinate your submission. You may contact Jonathan Toronchuk at (604) 829-
9627 8:30 a.m. to 5:00 p.m., Monday to Friday. Please do not mail, drop-off or courier your
response because this will delay the processing of your application.

Partial submissions will not be accepted. Written response describing how you have addressed
each of the Prior to Letter conditions is required (detailed explanation of changes assists us to
understand your rationale and convey the information efficiently and effectively to all review

groups).

1.0 Prior to the issuance of the Development Permit, revised digital drawings shall be submitted, to the satisfaction of the
Director of Planning, clearly indicating:

Development Review Branch conditions:

1.1 Design development to ensure “light well” located at Basement Level does not project more than 1m (3’-3”)
depth from face of building:

(Note to Applicant: The current proposed “light well’ at the Basement level projects 6’-6” from face of the
building and must be revised to comply.)

1.2 Design development to ensure only one laundry room is provided for each dwelling:
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1.3

(Note to Applicant: The current proposed plans indicate (2) laundry rooms at the basement level of the primary
dwelling)

provision of the following notations to be included on the submitted plans:

“The design of the parking structure regarding safety and security shall be in accordance with Section 4.13 of
the Parking By-law”;

“All building dimensions, setback and yards are to the outside of cladding”; and

(Note to Applicant: Ensure floor plans indicate dimensions are to cladding.)

“Mechanical equipment (ventilators, generators, compactors, and exhaust systems) will be designed and
located to minimize noise impacts on the neighbourhood and comply with Noise By-law No. 6555”

Landscape Review conditions:

1.4

1.5

1.6

1.7

Design development to ensure safe retention of all existing trees as follows:

Revise the tree protection barriers of Tree #1 to match with arborist report requirement, and relocate the gas
line to be outside the tree protection zone.

(Note to Applicant: The tree barrier size has to be no less than 18’-9” at North and East side, and 4 ft at West
side. Ensure dimensions to be measured from the edge of tree trunks)

Add tree protection barriers and dimensions for Tree #7, #8 and #9, and arborist specifications for tree
retentions.

(Note to Applicant: Refer to Landscape Condition 1.8)

iii. Relocate the garbage bin pad to be outside CRZ of Tree #9

Provide section details of the proposed structures within CRZ of retained trees with “alt” footings, including the
new fence at south and side property lines, new stairs and retaining wall within CRZ of Tree #6 and 7, the
East side foundation wall of the garage within CRZ of Tree#9.

(Note to Applicant: Further comments will be provided after reviewing structural details)

Design development to verify the location of Tree #7 by updating survey plan.

(Note to Applicant: The location of the tree at survey plan didn’t match with arborist report finding)

Provision of coordinated and complete site plan.

(Note to Applicant: The layout of outdoor patio and stairs on SITE PLAN didn’t match with floor plans; also add
tree #5 on SITE PLAN)

Provision of updated Arborist Report to assess the development proposal and construction impact on trees,
and provide tree retention measures, updating tree management plan in the context of site plan.
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1.8

(Note to Applicant: Include but not limited to assess the construction activities within the critical root zone of
Tree #1, #6, #7 and #9, and specify “alt” footings; confirm tree #3, #4, #8 to be retained or removed.)

Provision of an Arborist Letter of Assurance signed and dated by owner, arborist and contractor.

(Note to Applicant: The letter of assurance should include all construction activities that require arborist
supervisions.)

2.0 Condition(s) to be met prior to the issuance of the Development Permit:

Development Review Branch conditions:

21

2.2

Written confirmation that Building Review Branch comments under 4.8 have been acknowledged and
understood, is required to be submitted as part of the “prior-to” response.

Written confirmation that Building Review Branch comments under 4.4 have been acknowledged and
understood, is required to be submitted as part of the “prior-to” response.

Engineering Services conditions:

23

Provision of a copy of a current title search for each parcel of land involved in the development site which must
include copies of all non-financial charges and legal notations listed on each title search.

(Note to Applicant: Title search must include current title owner(s))

Examples of common non-financial charges include: Statutory Right of Way, Right of Way, Covenant,
Easement, Option to Purchase, and Easement and Indemnity.

Examples of financial charges, which are not required, include: Mortgage, Assignment of Rents, and Builders
Liens.

This information may be obtained from the Land Title Office in New Westminster. An applicant may require
advice or assistance from a Solicitor, Notary, Realtor, BC Land Surveyor, or Land Agent to obtain this
information.

We reserve the right to ask for an updated title search and charges prior to issuance of the permit

3.0 Conditions of the Development Permit:

3.1

3.2

All approved off-street vehicle parking, loading, and unloading spaces, and bicycle parking spaces shall be
provided in accordance with the relevant requirements of the Parking By-law prior to the issuance of any
required occupancy permit, or any use or occupancy of the proposed development not requiring an
occupancy permit, and thereafter permanently maintained in good condition.

All landscaping and treatment of the open portions of the site shall be completed in accordance with the
approved drawings prior to the issuance of any required occupancy permit, or any use or occupancy of
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4.0

3.3

3.4

the proposed development not requiring an occupancy permit, and thereafter permanently maintained in good
condition.

(Note to Applicant: In cases where it is not practical, due to adverse weather conditions or other mitigating
factors, to complete the landscaping prior to occupancy of a building, the City will accept an Irrevocable Letter
of Credit [amount to be determined by the City] as a guarantee for completion of the work by an agreed upon
date.)

In accordance with Protection of Trees By-law Number 9958, the removal and replacement of trees is
permitted only as indicated on the approved Development Permit drawings.

This Development Permit is valid for a period of 12 months from the date of issuance - unless otherwise
validated by a Building Permit.

Notes to Applicant:

4.1

4.2

4.3

4.5

4.6

4.7

It should be noted that your Development Permit will be issued when you have complied with all the above
conditions. However, if these conditions have not been complied with on, or before February 28, 2022, this
Development Application may stand refused.

A new Development Application will be required for any significant changes. This approval is subject to any
change in the Zoning and Development By-law or other regulations affecting the development that occurs
before the permit is issuable. No permit that contravenes the by-law or regulations can be issued.

If this application necessitates the demolition of existing residential rental, per Section 10.8.2 and except as set
out in section 10.8.3, where development necessitates the demolition of existing residential rental
accommodation, no development permit shall be issued for the demolition unless and until a development
permit for the new development has been issued. No development permit shall be issued for the demolition
unless and until a development permit for the new development has been issued.

(Note to Applicant: The development permit for the new development shall not be issued unless and until all
building permits for the new development and a building permit for the demolition are issuable.)

If this Development Application included a written notification of neighbouring property owners or other
interested parties, a copy of this letter will be sent to all respondents advising them of the decision.

The Canadian Electrical Code regulates high voltage overhead conductor clearances from structures and
dielectric liquid-filled transformer clearances from combustible building surfaces, doors, windows, and
ventilation openings. All structures must have a horizontal distance of at least 3 m from existing BC Hydro high
voltage overhead conductors. Combustible building surfaces, windows, doors, and ventilation openings must
be located at least 6 m from dielectric liquid-filled, pole-mounted BC Hydro transformers, unless an acceptable
non-combustible barrier is constructed between these transformers and combustible building surfaces, doors,
windows, or ventilation openings.

If the building design cannot meet these requirements, modifications must be made. If you wish to discuss
design options, please contact Electrical Inspections Plan Reviewer at 604.871.6401.

This application may be eligible for Development Cost Levy (DCL) Waiver.
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4.8

Yours truly,

Additional fees, conditions and processing time may be required should a Development Cost Levy
DCL Waiver be pursued. More information is available at: https://vancouver.calfiles/cov/development-
cost-levies-bulletin.pdf

Submission of most Building Permit applications now requires an appointment. When your Building Permit
application is ready, please phone 604.873.7611 to book an appointment for an application intake with the
Project Coordinator who will manage your application. Only full and complete applications will be accepted.
For additional information on obtaining a Building Permit for this proposal please visit vancouver.ca/building-
permit. If you need advice in preparing your application, you may book an enquiry appointment
(604.873.7611), or submit questions to https://lvancouver.calhome-property-development/contact-
development-buildings-or-licensing.aspx

Jonathan Toronchuk,
jonathan.toronchuk@vancouver.ca

(604) 829-9627
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From:
To:
Date:
Subject:

Attachments:

"Toronchuk, Jonathan" <Jonathan.Toronchuk@vancouver.ca>
6/25/2021 10:46:46 AM

Development Permit - 1265 E. 19th Ave. - DP-2021-00495 - Public
Notification Site Sign
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Gotham True Type Font\Gotham-XLightltalic\GOTHMXIT.TTF
Site Sign Email - 1265 E. 19th Ave. - DP-2021-00495.docx
Site Sign Guidelines.pdf

Site Sign Location Map Instructions.pdf
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Hello Charles,

The City of Vancouver has introduced a new look for development site signs as part of our ongoing efforts to improve our notification
processes. Our goals are for a consistent look with easier-to-read information that provides residents with a clear picture of what the
application is proposing and the process for review. The site signs are based on a look that has already been in use for rezoning and
more recent development applications.

Applicants will be provided with a template (see attached) and will be responsible for creating the sign based on the new look.
Applicants will also continue to work with City staff to ensure the appropriate information is included on the sign. Signs should not be
printed and installed until City staff have approved the design.

Please review these attachments, and the template, and work with your staff (or another graphic designer) to draft a pdf of the sign for
my review, with the following information included (red letters ) correspond to the Guidelines attached).

A Address of the site
1265 E 19TH AVE

DP-2021-00495

B Details:
Under the site’s existing RT-10 zoning, the application is to demolish existing One-Family Dwelling character home to develop
a two storey One-Family Dwelling with a Secondary Suite, and a two car garage at the rear of the site having vehicular access
from the lane, consisting of:

» A proposed Floor Space Ratio of 0.60 for the site. (Approximately 2445 sq. ft.)
* A proposed height of approximately 33.58 ft.

C Applicant information
Charles Fawkes

D Proposed Development or Building Image

E Location Image (see location map instructions attached)
« Map with the site and streets clearly labeled so the location is easily identifiable
« Size: 22.125 inches width x 20.125 inches height (Picas=132p9 x 120p9) at 300 ppi, pixels per inch (same as dpi, dots
per inch)

F Progress Timeline
o Development application submitted on May 27, 2021

e Application review by City staff, advisory panels and committees
¢ Decision by Director of Planning

G Contact and further information

...or phone the Project Coordinator at 604.829.9627

Frequently Asked Questions

| don’t know how to use the templates and/or don’t have the software. What do I do?

All applicants are responsible for the creation and installation of the site sign as required. If you do not have the resources to work with
the template, you may contract a graphic designer (generally available through a sign printing company) who can help complete the

work.

What software do | need to use the template?

The site sign template requires Adobe InDesign. The standard font for the sign is @@tBAMncouver - FOI 2022-234 - Page 69 of 185

| can’t get the location map files to work despite the instructions



Location maps can be created or provided in other formats as long as the information is clear, easy to read and works within the
template. The map image must be created at a resolution high enough to be used on the site sign without significant blurring or
pixilation.

If you have any further questions or concerns, please do not hesitate to contact me.
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GUIDELINES FOR DEVELOPMENT APPLICATION SITE SIGNS

Developers submitting an application for rezoning or a development that might have significant impact on a community
must install a site sign on their property to inform local residents of their plans.

PURPOSE

To grab resident/stakeholder attention, provide straight forward, high level information and drive people to vancouver.ca
for more detailed information.

DESIRED OUTCOME
Residents have a clear idea of what the proposal is, leading to informed input or dialogue.

DEVELOPMENT APPLICATION SITE SIGNS PROCESS

1)
2)

3)
4)
5)

6)
7)

City staff advises the applicant of site sign requirement.

City staff inform applicant of the fields of information required for the site sign and provide the required design
template for the site sign.

Applicant works with City staff to ensure the text and images are appropriate for the site sign.

Applicant must use the template (can either do the work on their own or contract a printer/designer) to create a
PDF design file of the site sign for City approval. The designer should use the set template and not replace fonts
or layout of the information.

Once City staff approves the sign design, the applicant sends the file to a sign shop for production and
installation. [The sign dimensions are 4.0’ x 8.0’; to be installed in a location that is easily seen from the street.]
After installation, the applicant will provide a photograph of the installed sign to City staff.

The applicant is responsible for updating the sign as needed if there is new information to be shared (e.g. open
house or public hearing dates) as directed by City staff.

DEVELOPMENT SITE SIGN INFORMATION

A Address of the site
Include DE number for development applications.

B Details of project
Provide high-level, bulleted description of the project in plain English. Try to simplify planning/development
language and terms as much as possible.

C Applicant information
Include name and address of applicant.
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D Proposed Development or Building Image (if required)
8) Colour frontage or elevation
9) Size: 22.125 inches width x 20.125 inches height (Picas=132p9 x 120p9) at 300 ppi, pixels per inch
(same as dpi, dots per inch)
10) Ensure you are placing the image in the square, not on top of it. Select the square, then use “place”.

E Location Image
11) Map with the site and streets clearly labeled so the location is easily identifiable
12) Size: 22.125 inches width x 20.125 inches height (Picas=132p9 x 120p9) at 300 ppi, pixels per inch
(same as dpi, dots per inch)
13) Include a north arrow (City staff to provide file)

F “What’s happening” Progress Timeline
To show the process and opportunities for public input. The timeline will typically include:

« If applicable: Rezoning approval (month/year when it was approved)
» Development application submitted (month/ year)

* If required: Open house details (include date, time, location, address)
« Application review by City staff, advisory panels and committees

* Decision by Development Permit Board OR Director of Planning

G Contact and further information

o DP Board applications:
include contact information for Development Permit Board meetings, development application web
address and phone number of project contact.

OR

¢ Director of Planning applications:
include contact information for development application website and phone number of project contact.

OTHER NOTES FOR GRAPHIC DESIGNERS:

e Ensure all font (Arial) and weights are consistent. Bullets should also be Arial font.
e Under “What’s happening”: the light blue circle should be even with the last line of type. All triangles
should be even with the first line of type. And a blue line should be beneath the last line of type.
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Creating location maps for City of Vancouver site signs

The City of Vancouver has a standardized set of wayfinding maps that should be used
for site signs.

The maps are available here (sign up not required):
https://www.dropbox.com/sh/x1Ifrfiamubloylr/AACowlHcnvjyX8tRn7fIDQpYa?dI=0

How to create a location map for a site sign:

1.Using the files in the Dropbox link, determine which map you will need by looking
at Finder Maps > (list view) "citywide-map-tile-reference.jpg”. Choose the section of
the city where the address you are plotting is located.

DOWNTOWN.jpg
NORTHEAST.jpg
NORTHWEST.jpg
SOUTH.jpg

SOUTHEAST.jpg
SOUTHWEST.jpg

2. Open the chosen jpg from the list above in Adobe Photoshop. Adjust the view so
you can see the entire map.

3. Go to Toolbox, select the Rectangular Marquee Tool (top right icon - dashed
square), and create a box around the area that you would like to crop out. Remember to
leave a little more on the sides than you need so you have room to manoeuvre your map
around in InDesign.

4. With the box that you just created still highlighted, go to Image > Crop which will cut
your box down to the size that you want. Save this cropped map at 600 ppi (pixels per
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inch), as a jpg, using a different name than the bigger map you took if from. Let’s call this
cropped map “map.jpg" for our purposes. Keep this map.jpg in the same folder with
your InDesign file of your site sign.

5. Now go into InDesign, select the image box in the site sign that you want

the map.jpg to appear in. Place the map.jpg that you just created, in the box you have
selected, and use the Direct Selection Tool (white arrow) to move the image around
and to change the map.jpg size in the box until it is how you want it to look.

6. With the map.jpg set in place in your InDesign site sign file, draw the proposed
building location shape onto your map, using the Pen Tool in InDesign. The standard
colour for this is 100% magenta + 100% yellow to make bright Red. Go to Objects >
Effects > Transparency and designate the Red colour as “Multiply” (instead of Normal)
with Opacity 50% to make the red shape transparent with a red tint. (Note: you can also
make the location shape in Photoshop, or bring the jpg into lllustrator if you prefer to do
this.)

7. The “YOU ARE HERE” wording is on the Master page in InDesign. You can move
this around to where you want it on top of map.jpg. The compass icon for the map is
also in InDesign, so you move this around on top of the map to where you want it.

8. When you are happy with your InDesign site sign, Save As. Then go to File > Export
and save your site sign as a pdf. The pdf is what you send to print.
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What’s happening:

Development application
submitted on January 12, 2015

DEVELOPMENT
APPLICATION

1177 Jervis Street
DE418742

Application review by

City staff, advisory panels
and committees

Decision by Director
of Planning

DETAILS

At this address, under existing zoning, the application
IS to construct:

PROPOSED BUILDING

The City iIs committed to supporting
Vancouver’s economic and community

e a 19-storey residential building that includes social recovery from COVID-19.

housing, market condos, and a commercial unit on

To learn more or provide input on
the ground floorv.

this project:

e three levels of underground parking, accessed off
the lane.

e Visit shapeyourcity.ca/development
e Scan the QR code below

e Phone the Project Facilitator at
604-829-X XXX

LOCATION VANCOUVER

APPLICANT: Intracorp Jervis St. Limited Partnership

900 - 666 Burrard Street
Vancouver, BC




From: "Charles fawkes" _

To: "Mei, Anna" <Anna.Mei@vancouver.ca>
Date: 9/16/2021 2:57:05 PM
Subject: [EXT] Re: [EXT] Re: [EXT] Re: Intake Drop Off Date - 1265 East 19th
Ave (BP after DP-2021-00495) - Week of September 7th, 2021

Attachments:  Arborist_Report_21-008.1_-_FIRCCNSSNN - 1265 _E._19th_Ave,
_Vancouver - Sept'21.pdf

City of Vancouver security warning: Do not click on links or open attachments
unless you were expecting the email and know the content is safe.

Hi Anna

Please find a revised (updated) Arbourist report with letter of retention (I assume this
is equatorial an Letter of Assurance?) for 1265 East 19th.

Let me know if you need anything further
Regards,
Charles

On Wed, Sep 15, 2021 at 12:13 AM Mei, Anna <Anna.Mei@vancouver.ca> wrote:

Good Afternoon Charles,

No problem, | will disregard the second comment.

Thank you for the update on the Letter of Assurance from your Arborist.

Sincerely,

Anna Mei | Office Support Clerk
Housing Review Branch
Development, Buildings & Licensing

City of Vancouver |515 W 10th Ave
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weeks so | did drop off the drawings to your attention last week and will forward
the loc to you as soon as | see it (I am away on holiday in Europe but | will be in
contact via email).

| also noticed Friday that the drawings | dropped off did not have sewer stamps. |
have instructed my assistant to drop off 2 new sets of architectural with stamps to
your attention this morning. Sorry for the oversight.

Regards,

Charles

On Thu, Sep 9, 2021 at 3:20 PM Mei, Anna <Anna.Mei@vancouver.ca> wrote:
Good Afternoon Charles,

Thank you for your attachments and email.

Have you located the Letter of Assurance?

Sincerely,

Anna Mei | Office Support Clerk
Housing Review Branch
Development, Buildings & Licensing

City of Vancouver |515 W 10t Ave
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meet compliance with the Zoning and Development By-law.

Further, we will also be collecting fees for extending the validity of the permit
applications with respect to both the Zoning and Development By-law and
the Vancouver Building By-law. These fees are applicable as stated in the
Fee By-law. Attached is a copy of the Schedule of fees for Development and
Building related permits: https://vancouver.calfiles/cov/vancouver-
development-building-permit-fees.pdf

UPDATE ON BASEMENT and CELLAR
REGULATIONS FOR NEW HOUSES IN RS ZONES:

On November 5, 2019, in a Public Hearing, City Council approved a report
by staff to recommend changes to the basement and cellar depths for new
houses in RS zones. All new applications must meet the new regulations.

Please refer to this link for the Council presentation:
https://council.vancouver.ca/20191105/phea20191105ag.htm (Item #1)

UPDATE ON NEW 2019 VBBL:

New VBBL 2019 (#12511)

On July 23, 2019 City Council passed a new 2019 Building By-law (By-law
#12511). This By- law will become effective on November 1, 2019. This was
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followed by an amendment (By-law #12512) which amends the new 2019
Building By-law to implement the phased implementation of new
requirements for Water Systems (January 1, 2020 and July 1, 2020) and
Energy Efficiency (June 1, 2021 implementation).

Please note that the Provincial Announcement on August 14th, 2019
regarding free access to BC Building Codes will impact how we roll out the
new Building By-law. As the Building Bylaw is tied to licensing agreements
that came with the National Code and the Provincial Code, our fee structure
has always been tied to these publications. As both the National and
Provincial codes will now be permitting free access, the Chief Building
Official is likewise pleased to release our new Building By-law for free as
well.

View the entire 2019 By-law via this link: https://app.vancouver.ca/bylaw_net
[Report.aspx?bylawid=12511

NOTE: This is the regulation at this point in time, and will not be updated with
errata or future amendments.

Preview the 2019 VBBL Unique-to-Vancouver substantive changes from the
2018 BC Building Code via this link: https://vancouver.ca/files/cov/2019-vbbl-
substantive-changes-list.pdf

Electronic and print versions of the new Building By-law will be available
from Queen=+s Printer in the near future via this link:http://www.bccodes.ca
[vancouver-bylaws.html [bccodes.ca]

TRANSLINK DEVELOPMENT COST CHARGES
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(effective January 15, 2020):

Development cost charges (DCCs) are applied to new developments in
Metro Vancouver to help fund the construction or expansion of regional
transportation projects by TransLink. This new "Regional Transportation
DCC* was introduced in 2018 to assist in paying for eligible projects of the
Phase One and Phase Two Investment Plan. The DCCs are imposed by By-
law.

Attached is a link to learn more about the DCCs and how it is calculated:
https://www.translink.ca/About-Us/Taxes/Development-Cost-Charges.aspx

[translink.ca]

Useful links to our City website:

Information on preparing a plan for a new house (one-and two-family
dwellings outright’):

http://vancouver.ca/lhome-property-development/1-and-2-family-home-
contruction-outright.aspx

Demolition and deconstruction permits:

http://vancouver.ca/home-property-development/demolition-permit.aspx

http://vancouver.ca/lhome-property-development/demolition-permit-with-
recycling-requirements.aspx
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Zoning map, districts, and regulations:

http://vancouver.ca/home-property-development/zoning-map-districts-and-
requlations.aspx

Zoning Bylaw administrative bulletins, including General and RS zone
specific administrative bulletins:

http://vancouver.ca/home-property-development/zoning-bylaw-
administrative-bulletins.aspx

Building a Passive House:

http://vancouver.ca/home-property-development/build-a-passive-house.aspx

NOTE: On January 21, 2020, staff presented a report to Council regarding
Simplified and Expanded Zoning and Development Regulations for Passive
House Projects. This will be referred to Council for a Public Hearing
sometime in late February, 2020 Read the staff report here:
https://council.vancouver.ca/20200221/documents/rr1.pdf

Energy-efficient requirements and resources for new homes and
renovations:

http://vancouver.ca/lhome-property-development/energy-efficiency-
requirements-and-resources-for-homes.aspx

Laneway House Regulations (Section 11.17 of the Zoning and
Development By-law), including ”How-to Guide‘:

https://bylaws.vancouver.ca/zoning/zoning-by-law-section-11.pdf

http://bylaws.vancouver.ca/bulletin/bulletin-laneway-housing-guide.pdf
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Duplex "How-to Guide* to building duplexes (outright):

https://vancouver.ca/files/cov/outright-duplex-how-to-quide.pdf
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DocuSign Envelope ID: EC70CA19-D5E7-48C2-BBAF-C413D3B77773
BURKLEY BUYD IKEE SERVIUE LI D. PAGE 2 OF 26

Purpose:

Burley Boys Tree Service Ltd. has been contracted to provide an updated tree inventory and
tree removal/retention outline for the property at 1265 E. 19th Ave, Vancouver, BC. Plans for the
development of the property include the construction of a new single family home with detached
garage.

This report is intended to accompany a development permit for the property which
includes the removal of 1 oversized tree on private property which is noted as being in
poor condition, with little or no long-term retention value, or inside/too close to required
excavations; not suitable for retention.

Any recommended tree removal should be considered in conjunction with an approved
replanting/landscape plan.

Method:

The site was visited with all trees being assessed from the ground only, using the Visual Tree
Assessment (VTA) technique. No trees were climbed or cored during the site visit. Assessed
trees and their Critical Root Zones (CRZ) are noted in the Appendix below. These CRZ should
be noted for design purposes and to avoid/limit any excavations or grade changes too close to
the trees as part of the proposed development.

Limitations:

Copyright 2021, Burley Boys Tree Service Ltd. This report is based on the method of
assessment on the day of the assessment only. It is not to be copied, reprinted, published or
otherwise distributed without prior approval by Burley Boys Tree Service Ltd. This report is to be
used in its entirety, for its purpose only. Only the subject trees were inspected, and no others.
This report does not imply or in any other way infer that other trees on the property or on
neighboring sites are sound and healthy.

The inherent characteristics of trees or parts of trees to fall due to environmental conditions and
internal problems are unpredictable. Defects are often hidden within the tree or underground.
The project arborist has endeavored to use his skill, education and judgment to assess the
potential for failure, with reasonable methods and detail. It is the owner’s responsibility to
maintain the trees to reasonable standards and to carry our recommendations for mitigation
suggested in this report.

It is the sole responsibility of the client or their representatives to follow through with all
recommendations for future consultations or site inspections.

FILE #21-008.1 | B22(0) | 1265 E. 19TH AVE, VANCOUVER, BC | 15SEPT21
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DocuSign Envelope ID: EC70CA19-D5E7-48C2-BBAF-C413D3B77773
BURKLEY BUYD IKEE SERVIUE LI D. PAGE 3 OF 26

Observations:

11 trees within or near the property were assessed. The trees are not individually tagged, but
they are referred to as Trees #1 through #11 in the Appendix below.

The proposed development includes the construction of a new home, with a detached garage at
the rear.

Tree #1 is a cherry growing on the City blvd. It measures 95cms DBH and is in good-fair
condition. This tree is to be retained; tree protection barriers are to be installed on either side of
the sidewalk to protect its CRZ.

Tree #2 is a boxwood hedge. It is in good condition with stems measuring 10cms DBH. This
hedge is shared with City property and also possibly with the west neighbour. It is to be
retained; tree protection barriers are to be installed along the drip line.

Tree #3 is an under-height cedar hedge lining the front entrance path, partially on CoV blvd.It
consists of 6 shrubs and is in fair condition. It is in conflict with the new front entry & will require
removal to facilitate construction activity. It is under 30cms DBH; a permit is not required.

Tree #4 is a magnolia, growing on the east side of the City blvd. It was not specifically plotted,
but its approximate location has been marked on the below survey. This tree measures 4cms
DBH and is in good condition. It is to be retained; tree protection barriers are to be installed at
0.24m.

Tree #5 is a 6cms DBH lilac. It was not specifically plotted, but its approximate location has
been marked on the below survey. This tree is in fair condition. It is in conflict with the building
envelope of the new house and will require removal to facilitate construction activity. It is under
30cms DBH; a permit is not required.

Tree #6 is a cherry growing on the east neighbour’s property, approximately 2m from the
property line. It measures 69cms DBH and is in fair-poor condition. This tree is to be retained;
tree protection barriers are to be installed at the excavation line. Its critical root zone is partially
inside the proposed building envelope of the new house & patio; Arborist supervision will be
required during excavations.

Tree #7 Cherry growing on the west neighbour’s property. It measures 60cms DBH and is in
poor condition; it has been previously topped and has visible decay and deadwood. This tree is
to be retained; tree protection fencing is to be installed. The canopy overhanging the property
can be pruned back to reduce the encroachment. Arborist supervision will be required
during any grade changes required for the new pathway between the house & garage.

Tree #8 is a Japanese maple. It is in good condition with multiple stems measuring a combined
17cms DBH. This tree is intended to be retained; tree protection barriers are to be installed at
1.02m. Arborist supervision will be required during excavations. At that time it may be
determined that It is in conflict with the new garage, if so removal may be required. It is under
30cm DBH, a permit is not required.
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DocuSign Envelope ID: EC70CA19-D5E7-48C2-BBAF-C413D3B77773

Tree #9 is a cherry growing at the NW corner of the east neighbour’s property. This tree
measures 65cms DBH and is in fair-poor condition. This tree can be retained with tree
protection barriers installed at the excavation line. The canopy overhanging the property can be
pruned back to reduce the encroachment. Arborist supervision will be required during
excavations for the new garage.

Tree #10 is a cypress growing at the center of the yard at the north property line. It has twin
stems at 0.5-1m above grade with a combined DBH of 122cms. This tree is in fair condition; it
has minor included bark but no signs of separation, has been previously topped multiple times
at 6-8m and hydro pruned on its north side. It also has 2 visible cavities of decay; 1 shows
internal decay, however, it has sound response growth, which indicates the decay is well
compartmentalized. This tree is in conflict with the building envelope of the garage; it cannot be
safely retained. This tree is proposed to be removed based on City of Vancouver’s
Protection of Trees Bylaw 9958 Section 4.5:(a) “the location of the tree is within a
building envelope defined or described under a development permit or building permit,
and changing the siting of an accessory building within that envelope to allow retention
of the tree is not possible;”.

Tree #11 is a laurel hedge growing on City property at the laneway at the NE corner. Its stems
measure approximately 15cms DBH and it is in fair condition. This hedge is recommended to be
partially removed to the east property line to facilitate access/construction activity. City
permission is required. Tree protection fencing is to be installed at the CRZ of the remaining,
retained section of the hedge.

s.22(1)
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